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Introductory Exercises
In Chemistry 103, you will be frequently collecting and evaluating data using computers. We will be using LoggerPro on the iBook laptops to collect and analyze data. We will also use computers to run programs, such as Atomic Microscope and Spartan, to demonstrate chemical principles. 
A.  Find the Relationship:  An Introduction to Graphical Analysis of Data Using LoggerPro

Science is most useful when it has some predictive value. In several of the laboratory investigations you will do this year, a primary purpose will be finding the mathematical relationship between two variables. In the upcoming GAS LAWS lab, you will determine the relationship between the volume of a confined gas and the pressure it exerts and the relationship between the pressure exerted by a gas and its temperature. Later in the semester, you will use similar methods during the IONIC COMPOUNDS #3 and STOICHIOMETRY #2 experiments. Determining mathematical relationships in laboratory science makes use of graphical methods.

GOAL


Every student should know how to analyze data sets using a spreadsheet program. In this course, the program we will use is LoggerPro. Analyzing data sets requires that you know how to enter data into the spreadsheet, plot the data, fit data sets to various mathematical relationships, and use the program to perform repetitive calculations. NOTE: Although you will be working in groups today, each student (working alone) will be “quizzed” on their ability to analyze a simple data set. 
OBJECTIVE

In this experiment, you will determine several mathematical relationships using graphical methods. The examples that follow illustrate the steps and the rationale for analyzing a data set. 

EXAMPLE 1

Suppose you have these four ordered pairs, and you want to determine the relationship between x and y:

x
  y

2
  6

3
  9

5
15

9
27

The first logical step is to make a graph of y versus x.




Since the shape of the plot is a straight line that passes through the origin (0,0), it is a simple direct relationship. An equation is written showing this relationship: y = k•x. This is done by writing the variable from the vertical axis (dependent variable) on the left side of the equation, and then equating it to a proportionality constant, k, multiplied by x, the independent variable. The constant, k, can be determined either by finding the slope of the graph or by solving your equation for k (k = y/x), and finding k for one of your ordered pairs. In this simple example, k = 6/2 = 3. If it is the correct proportionality constant, then you should get the same k value by dividing any of the y values by the corresponding x value. The equation can now be written: 

y = 3•x  (y varies directly with x)

EXAMPLE 2

Consider these ordered pairs:

x
  y
1
  2

2
  8

3
18

4
32

First plot y versus x. The graph looks like this:




Since this graph is not a straight line passing through the origin, you must make another graph. It appears that y increases as x increases. However, the increase is not proportional (direct). Rather, y varies exponentially with x. Thus y might vary with the square of x or the cube of x. 
The next logical plot would be y versus x2. The graph looks like this: 




Since this plot is a straight line passing through the origin, y varies with the square of x, and the equation is:

y = k•x2
Again, place y on one side of the equation and x2 on the other, multiplying x2 by the proportionality constant, k. Determine k by dividing y by x2:

k = y/x2 = 8/(2) 2 = 8/4 = 2

This value will be the same for any of the four ordered pairs, and yields the equation:

y = 2•x2  (y varies directly with the square of x)

 EXAMPLE 3



x
  y

  2
24

  3
16

  4
12

  8
  6

12
  4

A plot of y versus x gives a graph that looks like this:




Note that as x gets small, y gets large. A graph with this curve always suggests an inverse relationship. To confirm an inverse relationship, plot the reciprocal of one variable versus the other variable. 
In this case, y is plotted versus the reciprocal of x, or 1/x. The graph looks like this: 




Since this graph yields a straight line that passes through the origin (0,0), the relationship between x and y is inverse. Using the same method we used in examples 1 and 2, the equation would be: 

y = k(1/x)  or  y = k/x
To find the constant, solve for k (k = y•x). Using any of the ordered pairs, determine k:

k = 2 X 24 = 48

Thus the equation would be:

y = 48/x  (y varies inversely with x)

EXAMPLE 4

The fourth example has the following ordered pairs:

x
 y

 1.0
48.00

 1.5
14.20

 2.0
  6.00

 3.0
  1.78

 4.0
  0.75

A plot of y versus x looks like this:




Thus the relationship must be inverse. 
Now plot y versus the reciprocal of x. The plot of y versus 1/x looks like this:




Since this graph is not a straight line, the relationship is not just inverse, but rather inverse square or inverse cube.
The next logical step is to plot y versus 1/x2 (inverse square). The plot of this graph is shown below. The line still is not straight, so the relationship is not inverse square.




Finally, try a plot of y versus 1/x3. Aha! This plot comes out to be a straight line passing through the origin.




This must be the correct relationship. The equation for the relationship is:

y = k(1/x3)  or  y = k/x3
Now, determine a value for the constant, k. For example, k = y•x3 = (6)(2)3 = 48. Check to see if it is constant for other ordered pairs. The equation for this relationship is:

y = 48/x3 (y varies inversely with the cube of x)

EXAMPLE 5

The fifth example has the following ordered pairs:








X
Y








3.16
1








10
2








31.6
3








100
4








316
5

 The value for y increases as x value increases so the data appears to show a direct relationship. But, plots of y vs x, y vs x2, y versus x3, etc do not yield a linear fit for this data set. In many instances, functions other than xn are required to observe a linear relationship. 


For this particular data set, a linear relationship is observed in a plot of y versus log x. The equation for the relationship is y = k log (x) and a constant of 2 can be calculated from any two data pairs. Other common functions that are easily tried using the LoggerPro software are sqrt (square root or x^1/2), ln (natural log), and trigonometric functions such as sine and cosine. 
EXAMPLE 6

In many cases, the raw data collected in an experiment requires conversion to different units before it can be analyzed in a meaningful way. For example, temperatures are often measured in degrees Celsius but scientists must use the Kelvin scale in many equations. Therefore, every temperature data point must converted from degrees Celsius to Kelvin. The use a spreadsheet program avoids the very time-consuming process of manually converting each data point using a calculator.






Manually entered data


new calculated column






T (°C)
  
Pressure (atm) 

T(K)





0

0.916



273





12.5

0.958



285.5






25.0

1.000



298






37.5

1.040



310.5






50.0

1.083



323









In the sample data shown above, the temperature and pressure data were collected using the Vernier system. For proper data analysis, a new calculated column was used to generate the T data in Kelvin units.
MATERIALS

	computer
	

	Logger Pro 
	


PROCEDURE

1.
Obtain a set of problems from your instructor to solve using the graphical method described in the introduction. Follow the procedure in Steps 2-9 to find the mathematical relationship for the data pairs in each problem.

2.
Begin by opening the file “05 Find the Relationship” from the Chemistry with Computers folder of Logger Pro. Choose to continue without the interface.

3.
Enter the data pairs in the table. 

a. Click on the first cell in the x column in the table. Type in the x value for the first data pair, and press the ENTER key.

b. The cursor will now be in the first cell in the y column. Type in the y value for the first data pair, and press the ENTER key.

c. Continue in this manner to enter the remaining data pairs.


4.
Examine the shape of the curve in the graph. If the graph is curved (varies inversely or exponentially), proceed as described in the introduction of this experiment. To do this using Logger Pro, it is necessary to create a new column of data, x^n, where x represents the original x column in the Table window, and n is the value of the exponent:
a. Choose New Calculated Column from the Data menu. 

b. Enter a Name that corresponds to the formula you will enter (e.g., x^2, x^–1). Use an exponent of 2 or 3 for a power that increases exponentially, –1 for the reciprocal of n, –2 for inverse square, or –3 for inverse cube. Leave the Short Name and Unit boxes empty. 

c. Enter the correct formula for the column, (x^n) in the Equation edit box. To do this, select x from the Variables list. Following x in the Equation edit box, type in ^, then type in the value for the exponent, n, that you used in the previous step. Click [image: image1.png]Done




. According to the exponent of n you entered, a corresponding set of calculated values will appear in a modified column in the table.

d. Click on the horizontal-axis label, select x^n. You should now see a graph of y vs. x^n. To autoscale both axes starting with zero, double-click in the center of the graph to view Graph Options, click the Axis Options tab, and select Autoscale from 0 from the scaling menu for both axes. Click [image: image2.png]Done




.


5.
To see if you made the correct choice of exponents:

a. If a straight line results, you have made the correct choice—proceed to Step 6. If it is still curved, double-click on the calculated column, x^n, heading. Decide on a new value for n, then edit the value of n that you originally entered (in the x^n formula in the Equation edit box). Change the exponent in the Name. Click [image: image3.png]Done




.

b. A new set of values for this power of x will appear in the modified column; these values will automatically be plotted on the graph. 

c. You should now see a graph of y vs. x^n. If necessary, autoscale both axes starting from zero.

d. If the points are in a straight line, proceed to Step 7. If not, repeat the Step-5 procedure using integer n values between -4 and 4 until a straight line is obtained. If you have attempted all n values between 4 and -4 and still have not found a linear relationship, try fitting the data using other mathematical functions as described in step 6. 

6.   

Data sets can be fit using certain mathematical functions. One way to fit the data involves the calculating a new data column using the “Function” menu.
a. Choose New Calculated Column from the Data menu.

b. Enter the Name of the function you will use.

c. Click on the “Function” pull-down menu. Scroll down and click on the function you wish to use. The function name should appear on the equation line followed by a pair of brackets.

d. Get a blinking cursor inside the brackets by clicking inside the brackets. On occasion, the cursor is already in the brackets. Then click on the Variables pull-down menu and choose the variable x. The equation line should now read as follows: function name(“X”). For example, if you chose the natural log function, ln, the equation line would read, ln(“X”).  

e. Click “Done” and display the new calculated column on the x-axis as before (step 4d.)

7.
After you have obtained a straight line, click the Linear Fit button, 

. The regression line is calculated by the computer as a best-fit straight line passing through or near the data points, and will be shown on the graph. Record the value of the constant, k, produced by the fit

8.
Since you will need to use the original data pairs in Processing the Data, record the x and y values, the value of n used in your final graph, and the problem number in the Data and Calculations table (or, if directed by your instructor, print a copy of the table).


9.
To print your linear graph of y vs. x^n:

a. Label the curves by choosing Text Annotation from the Insert menu, and typing the number of the problem you just solved in the edit box (e.g., Problem 23). Drag the box to a position near the curve. Adjust the position of the arrowhead by clicking and dragging it.

b. IF DIRECTED BY YOUR INSTRUCTOR, print your graph. Enter your name(s) and the number of copies of the graph.


10.
To confirm that you made the right choice for the exponent, n, you can use a second method. Instead of a linear regression plot of y vs. xn, you can create a power regression curve on the original plot of y vs. x. Using the method described below, you can also calculate a value for a and n in the equation, y = A•x^n.

a. To return to the original plot of y vs. x, click on the horizontal-axis label, and select x. Remove the linear regression and annotation floating boxes.

b. Click the Curve Fit button, 

. 

c. Choose your mathematical relationship from the list at the lower left: Use Variable Power (y = Ax^n). To confirm that the exponent, n, is the same as the value you recorded earlier, enter the value of n in the Power edit box at the bottom. Click [image: image4.png]Try Fit




.

d. A best-fit curve will be displayed on the graph. The curve should match up well with the points, if you made the correct choice. If the curve does not match up well, try a different power and click [image: image5.png]Try Fit




 again. When the curve has a good fit with the data points, then click [image: image6.png]OK




. 

e. (Optional) Print a copy of the graph, with the curve fit still displayed. Enter your name(s) and the number of copies of the graph you want, then click [image: image7.png]OK




.

11.   To do another problem, reopen “05 Find the Relationship.” Important: Click on the No button when asked if you want to save the changes to the previous problem. Repeat Steps 3-10 for the new problem.

PROCESSING THE DATA

1.
Using x, y, and k, write an equation that represents the relationship between y and x for each problem. Write your final answer using only positive exponents. For example, if y = k•x-2, then rewrite the answer as: y = k / x2. See the Data and Calculations table for examples.

2.
Solve each equation for k. Then calculate the numerical value of k. Do this for at least two ordered pairs, as shown in the example, to confirm that k is really constant. See the Data and Calculations table for examples. 


For a given problem, how do the k values calculated using data pairs compare to the k value obtained through the linear fit?

3.    Rewrite the equation, using x, y, and the numerical value of k.

OPTIONAL: TWO-POINT FORMULA

A two-point formula is one that has variables for two ordered pairs, x1, y1, and x2, y2. To derive a two-point formula, a constant, k, is first obtained for a direct or inverse formula. All ordered pairs for a particular relationship should have the same k value. For example, in a direct relationship (y = k•x), first solve for k (k = y/x). Thus y1/x1 = k, and y2/x2 = k. Since both k values are the same:

 
[image: image8.wmf]2

2

1
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In another example of an inverse square relationship, y = k/x2 or k = y•x2. If k = y1•x12 and k = y2•x22, then:

y1•x12 = y2•x22
Derive a two-point formula for each of the three problems you have been assigned. Show the final answer in the space provided in the Calculation Table.
PERFORMING REPETITIVE CALCULATIONS USING LOGGERPRO
1. Obtain a new data set and enter it into a new “Find the Relationship” File.
2. LoggerPro can be used to perform the same mathematical operation to each value in a data set using the following steps. Add 100 to each value in your data set.
a. Choose New Calculated Column from the Data menu. 

b. Enter “Addition” as the Name. 
c. Enter the correct formula for the column into the Equation edit box as follows. Select x from the variables pull-down menu. “X” should appear in the edit box. Complete the equation by typing + 100 after “X”. In the Equation edit box, you should now see displayed:
     “X” + 100. Click [image: image9.png]Done




.

d. Scroll over to see the new calculated column in the file.
3. Repeat steps 2b-e to subtract 50 from each value in your data set. 
4. Repeat steps 2b-e to divide each value in your data set by 2. The symbol for the division operation is a backslash (/).  (your equation should read “X”/2)

5. Repeat steps 2b-e to multiple each value in your data set by 5.  The symbol for multiplication is an asterisk (*).

6. Show your new calculated columns to your instructor.
DATA AND CALCULATIONS TABLE

	Problem Number _____
	
	Problem Number _____
	
	Problem Number _____

	X
	Y
	
	X
	Y
	
	X
	Y

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	

	n (exponent)= _____

 m (from fit) = _____
	
	n = _____

           m (from fit) = _____
	
	n = _____

m (from fit) = _____


	Problem
Number
	Equation
(using x, y, & m)
	Solve for “m”
(find the value of m
 for two data pairs)
	Final Equation 
(x, y, and 
value of m)

	example


	y = m/x2

	m = y•x2
m = (4)(2)2 = 16

m = (1)(4)2 = 16
	y = 16/x2


	
	
	
	

	
	
	
	

	
	
	
	


B. Endothermic and Exothermic Reactions:  An Introduction to Data Collection Using the Vernier System
Endothermic and Exothermic Reactions, is intended to get you accustomed to 1) safely handling and disposing of chemicals, 2) using LoggerPro and probes to collect data and 3) observing and interpreting chemical reactions involving heat changes. Below is a selected group of common LoggerPro commands for your reference.
Many chemical reactions give off energy. Chemical reactions that release energy are called exothermic reactions. Some chemical reactions absorb energy and are called endothermic reactions. You will study one exothermic and one endothermic reaction in this experiment. 

In Part I, you will study the reaction between citric acid solution and sodium hydrogen carbonate (baking soda). An equation for the reaction is:

H3C6H5O7(aq) + 3 NaHCO3(s) 

 3 CO2(g) + 3 H2O(l) + Na3C6H5O7(aq)

In Part II, you will study the reaction between magnesium metal and hydrochloric acid. An equation for this reaction is:

Mg(s) + 2 HCl(aq) 

  H2(g) + MgCl2(aq)

OBJECTIVES

In this experiment, you will

· Study one exothermic and one endothermic reaction.

· Become familiar with using Logger Pro.
· Collect and display data on a graph.

[image: image10.wmf]
Figure 1

MATERIALS

	computer
	Styrofoam cup

	Vernier computer interface
	250 mL and 100 mL beakers

	Logger Pro
	citric acid, 1 M H3C6H5O7, solution

	Temperature Probe
	baking soda, NaHCO3

	50 mL graduated cylinder
	hydrochloric acid, 1 M HCl, solution

	balance
	magnesium, Mg


I.  Reaction Between Citric Acid and Baking Soda

1.
Obtain and wear goggles.

2.
Place a Styrofoam cup into a 250 mL beaker as shown in Figure 1. Using the graduated cylinder, measure out 30 mL of citric acid solution and pour it into the Styrofoam cup. Place a Temperature Probe into the citric acid solution.

[image: image23.wmf]3.
Connect the probe to the computer interface. To open the program: Click on the LoggerPro icon in the dock at the bottom of the iBook screen. Prepare the computer for data collection by opening the file “01 Endo Exothermic” from the Chemistry with Computers folder of Logger Pro:  First click “File” then “Open.” 


Click on “Chemistry…Computers” followed by “01 Endo-Exothermic.” This will automatically optimize LoggerPro to collect and process data for a given experiment. Later you will be setting up your own sheets. 
[image: image24.jpg]Choose a File

<> = [U Chemistry with Computers :

 Network % Advanced..y w Vernier » @ & 01 Endo-Exothermic.cmbl

g Macintosh HD U Biology wi...Computers 0: 02 Freeze Melt Water.cmbl

Chemistry...Computers % 03 Another ...eezing.cmbl

Z Restore U Earth Scie... Computers » |I| & 04 Heat of Fusion.cmbl

g HARTSEL [" Middle Sc... Computers » & 05 Find the _..onship.cmbl
[" Nuclear R... Computers » % 06 Boyle's Law.cmbl

{3 Desktop [ Physical S... Computers » | | & 07 Pressure...erature.cmbl

f chemical - u Physics wi...Computers % 08 Fraction.. tillation.cmbl

A Applications u Real-Worl...Computers » % 09 Evaporation.cmbl

h Documents u Water Qua...Computers % 10 Vapor Pr...Liquids.cmbl

. ) [7 Additional Physics > # 11 Beer's Law.cmbl

[y Movies [ Apple Science Bundle L % 11B Beer's L...ercent).cmbl L

& Music {7 Elementary Science P 4 & 12 Temp an..lubility.cmbl &

) Pictures F‘ GIS (Geogr...fo System) > |Y & 13 Electrolﬁes.cmbl . "}'

( New Folder ) ( Cancel ) ( Choose )

Yy



[image: image25.jpg].', Logger Pro m Edit Experiment Data

qﬁﬁﬂ New 3N
Do

!‘1 Mo device connecta Save IES
i g Save As... N =
x | Import From >
| Export As >
1 I Page Setup...
- Printing Options...
4  Print... P

Print Data Table...
Print Graph...

- Settings For Untitled...

P ——





4.
Weigh out 10.0 g of solid baking soda into a 100 mL beaker.

5.
The Temperature Probe must be in the citric acid solution for at least 30 seconds before this step. Begin data collection by clicking [image: image11.png]I Collect




. After about 20 seconds have elapsed, add the baking soda (all at once) to the citric acid solution. Gently stir the solution with the Temperature Probe to ensure good mixing. Collect data until a minimum temperature has been reached and temperature readings begin to increase. You can click on [image: image12.png]Stop




 to end data collection or let the computer automatically end it after 300 seconds.

6.
Each group should collect experimental waste in a large 400 mL beaker. We will add waste from the second experiment (Part II) to this beaker. Do not dump down it the sink!


7.
To analyze and print your data:

a. Click the Statistics button, 

. In the statistics box that appears on the graph, several statistical values are displayed for Temp 1, including minimum and maximum. In your data table, record the maximum as the initial temperature and the minimum as the final temperature. Close the statistics box by clicking the upper-left corner of the box.

b. To confirm the minimum and maximum temperatures, use the scroll bars in the table to scroll through the table to examine the data. Compare the minimum and maximum data points to those you recorded in the previous step. 

c. Print a copy of the table. Enter your name(s) and the number of copies.

d. You will often want to change the scale of either axis of the graph. There are several ways to do this. To scale the temperature axis from 0 to 25°C instead of the present scaling, click the mouse on the “40” tickmark at the top of the axis. In place of the “40”, type in “25” and press the ENTER key. Notice that the entire axis readjusts to the change you made. Use the same method to change the “–10” tickmark to “0”. Note: A second option is to click the Autoscale button, 

. The computer will automatically rescale the axes for you.

e. You can also expand any portion of the graph by zooming in on it. Select the area you want to zoom in on. Do this by moving the mouse pointer to the beginning of this section of data—press the mouse button and hold it down as you drag across the curve, leaving a rectangle. Then click the Zoom In button, 

. The computer will now create a new, full-size graph that includes just the region inside the rectangle. You can reverse this action by clicking the Undo Zoom button, 

.

f. When you again collect data in Part II of this experiment, the data will be collected as Latest run, the most recent set of data you have collected. The original Latest run will be lost if it is not saved or stored. Choose Store Latest Run from the Experiment menu to store Latest as Run 1, then save or print it later. Note that the line for Run 1 is thinner than it was for Latest. To hide the curve of your first data run, click the Temperature vertical-axis label of the graph, click More, and uncheck Run 1 Temperature. Click [image: image13.png]OK




.

II.  Reaction Between Hydrochloric Acid and Magnesium

8.
Manually rescale the vertical axis to the original temperature scale of –10 to 40°C. To do so, click the mouse on the bottom tickmark and type in “–10”. Then click on the top tickmark and type in “40”. 

9.
Measure out 30 mL of HCl solution into the Styrofoam cup. Place the Temperature Probe into the HCl solution. Note: The Temperature Probe must be in the HCl solution for at least 45 seconds before doing Step 11. CAUTION: Hydrochloric acid is caustic. Avoid spilling it on your skin or clothing. Wear chemical splash goggles at all times. Notify your instructor in the event of an accident. 

10.
Obtain a piece of magnesium metal from the side bench.


11.
Begin data collection by clicking [image: image14.png]I Collect




. After about 20 seconds have elapsed, add the Mg to the HCl solution. Gently stir the solution with the Temperature Probe to ensure good mixing. CAUTION: Do not breathe the vapors! Collect data until a maximum temperature has been reached and the temperature readings begin to decrease.


12.
Add the waste generated in this experiment to your previous 400 mL waste beaker. Dispose of the reaction products as follows: IN THE SINK,WITH YOUR GOGGLES ON, add a scoop of the available NaHCO3 powder (baking soda) to the waste beaker and stir. Keep adding more NaHCO3 until the fizzing stops. When the fizzing stops, wash it down the sink drain. The reaction of baking soda with acid produces carbon dioxide gas and neutralizes the acid in the process producing an environmentally friendly solution. 

13.
To analyze your Part II data:

a. Change the appearance of the graph by double-clicking anywhere on the graph bring up the Graph Options dialog. Check the box in front of Point Protector—a point protector will now outline each data point on the graph window in this trial, click the Examine button, 

. The cursor will become a vertical line. As you move the mouse pointer across the screen, the temperature and time values corresponding to its position will be displayed in the box at the upper-left corner of the graph. Scroll across the initial 3-4 points to determine the initial temperature. Record the initial temperature in the data table. Move the mouse pointer across the peak of the temperature curve to determine the maximum temperature, and record it as the final temperature in your data table. To remove the examine box, click the upper-left corner of the box.

b. It is also possible to calculate statistics just for a portion of your collected data. To do so, you must first select the data you are interested in. For example, you might want to find the average (or mean) of the first few data points to use as an initial temperature, instead of using the minimum value. Select the flat portion of the curve—move the mouse pointer to time 0 and drag across the flat part of the curve. Now click the Statistics button, 

, and note the mean temperature value in the statistics box on the graph. This value is the mean of only the selected data points. When you are done, click on the upper-left corner of the statistics box to remove it.


14.
To print a graph of temperature vs. time showing both data runs:

a. Click the Temperature vertical-axis label of the graph. To display both temperature runs, click More, and check the Run 1 Temperature and Latest Temperature boxes. Click [image: image15.png]OK




.

b. Label both curves by choosing Text Annotation from the Insert menu, and typing “Endothermic” (or “Exothermic”) in the edit box. Then drag each box to a position near its respective curve. Adjust the orientation of the arrowhead by clicking and dragging to the desired position.

c. Print a copy of the graph. Enter your name(s) and the number of copies of the graph you want.


15.
Save the temperature and time data from both data runs. Choose Save As from the File menu and give the file a distinct name. As directed by your instructor, choose a location for the file, and click [image: image16.png]Save




.

DATA TABLE

	
	Part I
	Part II

	Final temperature, T2
	°C
	°C

	Initial temperature, T1
	°C
	°C

	Temperature change, T
	°C
	°C


OBSERVATIONS

PROCESSING THE DATA

1.
Calculate the temperature change, (t, for each reaction by subtracting the initial temperature, t1, from the final temperature, T2 ((T = T2 – T1).

2.
Which reaction is exothermic? Explain.

3.
Which reaction had a negative (T value? Is the reaction endothermic or exothermic? Explain.

4.
For each reaction, describe three ways you could tell a chemical reaction was taking place.

5.
Which reaction took place at a greater rate? Explain your answer carefully. 

Chemistry Lab with Logger Pro:

Frequently Used Commands
Data Collection

To open the program: Click on the LoggerPro icon [image: image17.wmf]  in the dock at the bottom of the screen.  Note: If the icon is not in the dock, double click on the Macintosh HD icon in the upper left corner of the screen.  In the window that opens, double click on the Applications folder.  In that window, double click on the Logger Pro 3 folder.  Finally, you can double click on the Logger Pro icon there to open the program.

To get the appropriate data collection setup: Click on File at the top of the screen.  Click on Open in the drop down box.  In the window that opens, the Experiments folder should be selected in the first column.  Click on the Chemistry with Computers folder in the second column.  Double click on the file your lab manual tells you to use in the next column that appears.

To collect data: Follow the directions for data collection in your lab manual, which will be specific to the lab.  If you need to collect more than one run, you need to store each run before beginning a new run.  To do this, click on Experiment at the top of the screen and choose Store Latest Run from the drop down box.  Note: If you forget to do this and attempt to collect more data, a window will open asking if you wish to store, delete, or append the latest run.  Choose Store Latest, but realize this delays your data collection and may require you to repeat part of your experiment.  

To hide or display runs: Move your cursor over the title of the y-axis.  When the arrow turns into y… click on the axis title.  Choose More from the box that opens.  You can hide a run by clicking to remove the check mark in front of it and then clicking OK.  To display hidden runs follow the same steps and click the box in front of the run to put a check mark in it. 

Analyzing Data

Statistics button, 
[image: image18.wmf].  Clicking this button will display several statistical values for your graph including: minimum, maximum, mean, median, standard deviation, and total points collected.  Note: If you have more than one graph displayed, a window will open and prompt you to choose the runs you want stats for.  Choose the run(s) you want by deselecting the runs you do not want.  You can close the statistics box(es) by clicking the X in the upper left corner.

To view statistics for a portion of the graph you must select that portion. Do this by moving the mouse pointer to the beginning of this section of data—press the mouse button and hold it down as you drag across the curve, leaving a blue rectangle.  Follow the steps above to view statistics for just the portion of the graph that is highlighted.

Examine button, 
[image: image19.wmf]. Click on this button and the cursor will become a vertical line. As you move the mouse pointer across the screen, the x and y values corresponding to its position will be displayed in the box at the upper-left corner of the graph.  If more than one run is displayed, the colors of the text for the dependant variables will correspond to the colors of the lines on the graph.  To remove the examine box, click on the X in the upper left corner of the box.

Linear Fit button, 
[image: image20.wmf].  Use this button to check for a direct relationship between your two variables.  Click on this button to show a best-fit linear regression line for your data points.  The line should pass through or near all of your data points.  The box that appears will tell you the slope of the line, its y-intercept, and its correlation.  The closer the correlation value is to 1 the better the fit.  To remove this box, click on the X in the upper left corner of the box.

Curve Fit button, 
[image: image21.wmf] 

.  This button can be used to help you calculate the equation of a curved line.  Detailed instructions will be in the lab manual if you need to use this function.

To zoom in on an area of the graph, you must select the area you want to zoom in on. Do this by moving the mouse pointer to the beginning of this section of data—press the mouse button and hold it down as you drag across the curve, leaving a blue rectangle.  Click the Zoom In button, which is a magnifying glass with a plus sign in it.  The computer will now create a new, full-size graph that includes just the region that was highlighted by the blue rectangle.  You can return to the original graph by clicking on the Zoom Out button, which is a magnifying glass with a minus sigh in it.  Click anywhere on the graph to remove the blue rectangle.

Preparing a Graph for Printing

Autoscale button, 
[image: image22.wmf].  Clicking on this button will rescale your axes so that your data fills the graph.  If you would prefer to set your own scale, click on the number of the highest value on the axis you want to change.  A text box with the highest value highlighted will appear.  Type the value you would like to change it to and press enter.  Repeat with the lowest value. 

To label curves or lines on the graph: Click on Insert at the top of the screen.  Click on Text Annotation in the drop down box.  A text box with an arrow will appear within the graph.  Click within the new text box to get the cursor set for typing.  Type your label.  You can change the size of the text box by placing your mouse pointer over the black boxes around the text box.  Once your mouse pointer turns into a double-sided arrow, press the mouse button and hold it down as you drag the edge of the box to the desired size.  You can move the text box by placing your mouse pointer over the text box until your mouse pointer turns into a hand.  Once this happens, press the mouse button and hold it down as you drag the text box to the desired location.  You can move the point of the arrow this way as well.  Place your mouse pointer over the end of the arrow until your mouse pointer turns into a hand.  Once this happens, press the mouse button and hold it down as you drag the pointer to the desired location.

Printing 

You may be asked to print graphs and/or data tables.  Click on File at the top of the screen.  To print a graph, choose Print Graph from the drop down box.  To print your table, choose Print Data Table from the drop down box.  If you just choose Print from the drop down box you will print the screen as you see it…the graph and the  portion of the data table that is displayed.  Next, the Print Options Window will appear.  In this window, be sure Print Footer is checked, type your name(s) in the Name box, below that, you can type any comments you would like to be on the print out.  You should also be sure Date, Page Number, Page Title, and Filename are all checked and then click OK.  Then the Print Window will open.  Be sure the printer selected is Brother HL-5170DN series.  In this window you can also change the number of copies to be printed if you need more than one.  Finally, click Print.
1
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